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Introduction 
EndNote is reference management application that academic writers use to 
streamline and simplify the research and writing process. 
This handout is designed to get you started using EndNote; it contains step-by-
step instructions on how to perform basic tasks. For more detailed instructions, or 
instructions on more complex tasks, please refer to the EndNote user guide 
(available in print or as a PDF file in the folder in which EndNote is installed) and 
EndNote’s online help system. 
 
Note: Endnote is available free to KU graduate students, faculty, and staff 
members. See www.technology.ku.edu/software/endnote for download and 
installation instructions. 

Objectives 
In this Endnote workshop, attendees will get started using EndNote in their 
research and writing. Specific topics include: 

• Search and Sort references 

• Export bibliographies and share references 

• Use EndNote’s Cite While You Write tools to insert formatted references 
and lists of works cited in Microsoft Word documents 

• Download and use EndNote filters, connection files, and output styles 

 
Related Training Available from Instructional Services 

All workshops offered by Information Services are free to KU students, staff, 
faculty, and approved affiliates.  
To learn more about or register for workshops, receive automatic announcements 
of upcoming workshops, and track workshops you’ve registered for and have 
attended, visit the www.lib.ku.edu/instruction. You can also check our online 
schedule at www.lib.ku.edu/instruction/workshops for a list of class offerings and 
their availability. For further workshop related questions, please email 
training@ku.edu. 
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Definitions 
Term Definition 

CWYW Cite While You Write. A set of tools included with EndNote that work 
with Microsoft Word, and allow you to insert properly formatted 
citations and lists of works cited automatically. 

EndNote 
Library (.enl) 

A database file, containing references that are imported, hand-
entered, or downloaded through a direct connection to a data source. 
An EndNote Library can contain an unlimited number of references, 
as well as images and other data (images are stored in a separate 
data file that is created when the library is created). EndNote 
Libraries have an .ENL file extension. 

Data folder 
(.data) 

This folder is considered part of the library; it includes images and 
other files necessary for the library. 

Field codes 
(used for 

citations and 
bibliographies) 

Endnote inserts a citation in Word by using a field code.  A field code 
is an imbedded command for Word to look back to EndNote for 
specific information.  Field codes are also used when creating form 
letters or when using formulas in Excel.  A field code is denoted by a 
grey field when you select it. Convert to Unformatted Citations will 
turn the field codes off and on.

EndNote 
Compressed 

Library 
(filename.enlx). 

A complete EndNote library (the filename.enl file as well as its 
associated .DATA folder and all of its contents) saved to a single 
compressed filename.enlx file in order to easily back up the library or 
send a copy to a colleague. This file can only be restored by 
EndNote version 10 or later. 

EndNote Style 
(.ens) 

A set of instructions used by EndNote to create bibliography entries 
formatted for a specific style (such as APA or Chicago) or publication 
(such as the New England Journal of Medicine). EndNote Styles 
have an .ENS file extension. 
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Your tool set: 

 Most of the tools found in the menu items (i.e. File, Edit, Reference, Tools, Window, 
Help) are duplicated as icons as well. Hovering your mouse over an icon will bring up a 
popup box to tell you about its intended use. 

Getting Started 
Your EndNote Library (or .ENL file) contains all the references you have 
collected.  EndNote will create a second item, a folder (.DATA).  This folder will 
hold your library attachments.  

Opening an EndNote Library 
1. Open EndNote. You may be prompted to create a new library, or select an 

existing library. 

2. Choose Open an existing EndNote library and click OK. 

3. In the Select a Reference Library box, navigate to the folder in which you 
have saved your library. 

4. Select your library and click Open. 

Working with Output Styles 
Output Styles (or .ENS files) are sets of instructions that tell EndNote how to 
format the bibliographic entries and citations it creates from references in a 
library.  
Several hundred styles are included with EndNote; however, when new versions 
of the styles you use are released, you will need to download them from the 
EndNote website. 

Downloading an Output Style 
To download an output style from the web: 

1. Many styles are available on EndNote’s web site at 
http://www.endnote.com/support/enstyles.asp.  

2. Find the hyperlink for the style you wish to download. Right-click the 
hyperlink, and choose Save Target as. (Mac users: Ctrl-click and choose 
Download Link to Disk.) 

3. In the Save In drop-down box, navigate to 
C:\Program Files\EndNoteX3\Styles and click Save. 
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Checking the Output Style  
To get information on a style, 

1. Click the Edit menu, select Output Styles, and then click Open Style 
Manager. 

2. Scroll to the style you wish to use, and click the name of the style to show the 
information associated with it. In the example shown below, the information 
for Chicago style is shown. (If you can’t see the information for a highlighted 
style, click the Show Info button.) 

 
3. Check to see whether the style is the version you need, and whether there are 

any limitations to the style you selected.  

4. Click the X in the upper left corner of the EndNote Styles dialog box to close 
it. 

Applying an Output Style 
To apply a style, 

1. Click the Current Style dropdown box located at the top of the library 
window.  

 
Figure 1: Select this option to find your bibliographic style 
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2. If the style you want to use appears in the dropdown list, choose it; otherwise, 
click Select Another Style (as shown above). 

3. In the Choose a Style dialog box, either scroll or use the Quick Search box 
find the style you want, then click the Choose button. 

To see what a bibliography entry formatted in this style will look, click a 
reference in the library window to select it, then click on the Preview tab in the 
under the library window. 

 
The formatted entry for the selected reference will appear in the lower window, as 
shown: 
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Figure 2: Preview of reference using Chicago 15th A 

Output styles that use Journal abbreviations 
If you are using a style that required the use of journal abbreviations you will 
want to import a Journal Terms list into your library. This will match full Journal 
names with their approved abbreviations.  Most journals will be included but you 
may find a few that are not.  You will need to manually add any missing journal 
abbreviations.  
 
1. From the Tools menu, select Open Term Lists and then Journals Term List. 
2. Delete all existing terms from the list (you can click and drag to highlight all 

terms, and then click Delete Term). 
3. Click on the Lists tab and highlight the Journals list. 
4. Click Import List. 
5. In the File dialog, navigate to the EndNote X3 \Term Lists folder, select the 

list you want to use, and click Open to import the journal names and 
abbreviations from the file into the Journals term list. 
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Exporting Bibliographies 

To export a formatted bibliography: 

Note:  EndNote will export from only those references listed in the current library 
window.  

• If any references in the Library window are selected, the EndNote export dialog 
gives you the option of exporting just those selected references. If you don’t 
choose the option to “Export Selected References,” then all of the references that 
are showing in the Library window will be exported.  

• To export all of the references in the Library, choose Show All References from 
the References menu. If any references are selected, be sure to uncheck the 
“Export Selected References” check box in the export dialog. 

• To export a subset of references use the Search References, Hide Selected 
References, or Show Selected References commands to show the subset of 
references you want to include.  

1. From within the EndNote windows you can select the output style you wish to 
use to format your bibliography.   

2. If you select specific references to export, use the Show Selected command 
from the References menu to display only those references. 

3. Click the File menu, and then click Export. 

4. In the Save In dropdown box, browse to the folder in which you’d like to save 
the exported bibliography. In the File Name text box, type the file name 
you’d like to give the bibliography, and in the Save as Type dropdown box, 
choose the file type you want for the exported bibliography. Choices include: 
Text, Rich Text (RTF), HTML, and XML. Select Rich Text (RTF) for a 
standalone bibliography suitable to print.  

5. In the Output Style drop down box, if you have not already done so, select 
the output style you wish to use to format your bibliography.   

6. Click Save to export the bibliography. 
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Using Cite While You Write in MS Word 

Note: CWYW is now compatible with Open Office Writer. 

 
One very useful feature of EndNote is Cite While You Write (CWYW), which 
enables you to insert formatted citations and build formatted lists of works cited 
within your documents with a click of a button. Once EndNote is installed, the 
CWYW tools appear in a toolbar at the top of the MS Word window, like this: 
 

 
Figure 3: CWYW in Word 2003 

Or as a ribbon in MS Word 2007: 
 

 
Figure 4: CWYW in Word 2007 

For Word 2003:  
If you don’t see these tools at the top of the Word window, right-click on 
the toolbar area and click “EndNote” on the right-click menu.  
The simplest way to get the tools to appear in Word 2000/XP/2003 is to 
run the Configure EndNote Utility from the EndNote Start Menu or the 
EndNote X3 Program Files folder. Once you run the utility, make sure 
"Configure EndNote components for me" is selected and click Next. 
Select the "Unified Cite While you Write for the Microsoft Word" option 
and click Next. Click Finish when you are done.  

Inserting citations 
To use CWYW tools, you must open your Word document, start EndNote and 
open your EndNote Library (.ENL file).  

Citing a Single-Reference Intext Citation 
To insert a single-reference citation in your Word document, 

1. Add a “Works Cited” heading (or use whatever wording you like) at the very 
end of your Word document. (CWYW will add a list of works cited at the end 
of the document automatically when you insert citations.) 

Instructional Services at KU Libraries - 9 - © 2009 The University of Kansas 
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2. Switch to EndNote and choose the Output Style you wish to use from the 
dropdown list in the EndNote toolbar. 

3. Click on the specific reference you want to cite to highlight it. Leave 
EndNote open, with this reference selected. (You can minimize the 
EndNote window or click the Word button in the toolbar at the bottom of the 
screen to return to Word without closing EndNote.)  

4. Switch back to Word, and click the Insert Selected Citation(s) button ( ). 
CWYW will add the citation in the text, and will add a bibliographic entry at 
the end of the document. 

 
Figure 3: CWYW in Word 2007 

Editing a Single-Reference Intext Citation 
1. To edit a citation such as adding a page reference or removing the author’s 

name, click on the inline citation and click the Edit Citation(s) button  

( ).  

 
Figure 4: Edit Citation 

2. In the EndNote Edit Citation dialog box, to add page numbers type the page 
number(s) in the “Pages” text box, and click OK. 
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Citing Multiple References for Inline Citation 
To insert a multiple-reference citation in your Word document, 

1. Add a “Works Cited” heading (or use whatever wording you like) at the very 
end of your document. (CWYW will add a list of works cited at the end of the 
document automatically when you insert citations.) 

2. Switch to EndNote and choose the Output Style you wish to use from the 
dropdown list in the EndNote toolbar. 

3. Click on one of the references you want to cite to highlight it. To select 
additional references, hold down the Ctrl key and click them. Leave EndNote 
open, with these references selected. (You can minimize the EndNote 
window or click the Word button in the toolbar at the bottom of the screen to 
return to Word without closing EndNote.) 

4. Switch back to Word, and click the Insert Selected Citation(s) button ( ). 
CWYW will add the citation in the text, and will add a bibliographic entry at 
the end of the document. 

5. To add page references to the citation, click on the inline citation and click the 

Edit Citation(s) button ( ). 

 
6. In the dialog box, click the first reference to select it, and then type the page 

number(s) for that reference in the “Pages” text box. Click the second 
reference and repeat the process as needed. Click OK to save the changes to 
the reference. (The example above shows pages 75-6 cited for the Andrew 
reference.) 

(Re)formatting Citations in Word 
To change the formatting of CWYW references and the list of works cited in 

Word, click the Format Bibliographies button ( ) on the CWYW toolbar or 

 on the EndNote Tab in Word 2007. Choose the 
formatting style you wish to use from the Output Style dropdown list, and click 
OK. 
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Note: If the Output Style you wish to use doesn’t appear in the 
dropdown list, click Select Another Style click the style you 
wish to use, and click Choose. You can also change this from 
within EndNote.  

Within Word, click the Format Bibliographies button ( ) or 

. The style you chose will 
appear in the Output Style dropdown list. 

Citing References in Footnotes or Endnotes 
Footnoting styles such as MLA and Chicago B will use these instructions. 
You must first create the footnote or endnote using the tools provided within Word. Once 
you have created a note in Word, you can cite references in that note just like you cite 
them in the body of the document.  
 
To cite a reference in a footnote or endnote:  

1. Use the appropriate command in Word to create the footnote or endnote. 
(EndNote does not create the footnote in the document, but is used to insert and 
format citations into the note.) 

2. Click on the specific reference you want to cite to highlight it. Leave EndNote 
open, with this reference selected. (You can minimize the EndNote window or 
click the Word button in the toolbar at the bottom of the screen to return to Word 
without closing EndNote.) 

3. Position the cursor in the footnote or endnote where you would like the citation(s) 
to appear. 

4. Switch back to Word, and click the Insert Selected Citation(s) button ( ). 
CWYW will add the citation in the text, and will add a bibliographic entry at the 
end of the document. 

 
 

Note: If you do not want an accompanying bibliography at the end of 
your document you may need to edit your output style. 

To do this go to Edit – Output Style and select your output 
style. Click on Footnotes – Templates uncheck the option to 
Include citations in bibliography

Citing References as Endnotes (i.e. ACS) 
In certain situations, such as ACS and ACS no title, EndNote is set up to create numbered 
endnotes without the use of the Word Reference tools.  If you use endnotes it is worth 
testing to see if your style is one of these.  To test, insert your citation using the same 
technique as or inserting an Inline Citation. If EndNote inserts a number and starts a 
bibliography then you do not need to use the Word Reference tools.  However, in cases 
such as MLA or Chicago B, if EndNote does not insert a superscript number but only 
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starts a bibliography then you will either have to use the Word Reference tool or you will 
need to edit the EndNote output style.  

Bibliographies 

Moving Bibliographies 
Cite While You Write always creates the initial bibliography at the end of the Word 
document that it has formatted. If you move the bibliography to a different location in the 
document, 
EndNote keeps it there even if you reformat the paper. You can drag-and-drop the 
bibliography, or, if Instant Formatting is disabled, you can Cut and Paste the 
bibliography. 
 

Creating Multiple Bibliographies in a Single Document 
By default, EndNote creates a single bibliography at the end of each of your Word 
documents. However, you may want to create a separate bibliography for each section (or 
chapter) in your document. 
 
To make this adjustment, see the Sections panel in the output style you are using. This is 
where you select the appropriate option for creating a single bibliography from all 
sections, a separate bibliography for each section individually, or both. 
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Figure 5: Edit Output style, look for Sections to set up multiple bibliographies. 

For more information on this see page 343 in the EndNote users manual included in your 
applications folder (EndNote.pdf )  
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Publishing, submitting and collaborating  

Working in groups 

Tracking Changes 
Many writers use some sort of “tracking changes” program when working with multiple 
editors. The easiest and most stable method for combining EndNote and MSWord’s 
Track Changes is to work with “un-formatted” citations within your document.  
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or 

 

 
Figure 6: click here to un-format your citations 

EndNote keeps track of citation in your document in one of two ways: as a formatted 
citation (represented by the grey shading around the citation when you click on it) and as 
an unformatted citation (represented by the citation information surrounded by brackets 
{Yu-Mei, 2002 #12}).   
 

Note:   
 
 

 

When you view your citations as un-formatted, you will not see 
your final bibliography. 
Return to Word, click the Update Citations and Bibliography 

button ( ) to see your final bibliography. 
 
Do not un-format your document if you do not have the 
original references in your libraries. Unlike formatted 
citations, unformatted citations require that you have the 
corresponding EndNote libraries open in order to format 
references. 

 
Provided you have the correct EndNote library for the paper, you can reformat you paper 
at any time to see how it looks.  Just remember to return it to its original un-formatted 
condition before sending it out again for editing.   
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Figure 7: click here to re-format your citations 

Emailing a draft 
It is a good idea to un-format your citations before emailing a draft of your paper 
to another person to edit.  

Using the traveling library 
A traveling library is a mini-EndNote library that contains only the citations you 
have used in a particular paper. When you send a traveling library with your 
document you will send your document with formatted citations.  Because 
reference data is kept with each formatted citation, you can collaborate with 
other authors on a paper without each author having the same EndNote library. 
The reference data saved with each citation includes all fields except Notes, 
Abstract, and Figure.  The library is saved as a separate .enl file from the 
document.  

Final work 

Submitting an electronic final copy 
Before you submit the final version of your paper, you must disconnect the paper 
from your EndNote library by removing the field codes. 

1. Save your final draft. 

2. Click on the Remove Field Codes icon on the EndNote toolbar or ribbon. 

 
or 

 
Figure 8: click here to remove field codes 

3. EndNote will give you a warning message that it is about to create a 
separate copy of your paper.  You will want to save both files: the final 
draft that you created (with field codes) and the second draft (without field 
codes). Name them so you know which one is which.  
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What about last minute additions after you have removed your field 
codes? 

When you find that you have last minute edits to make after you have removed 
your field codes you should make those edits in your draft that still has the field 
codes in it. (Now, aren’t you glad that you saved it?).  Once you make those edits, 
save it and remove the field codes just as you did before.  

Printing a final copy 
Provided your citations are formatted, you can print a paper created with EndNote 
just as you would any word processed document. The field codes will not show 
up but the citations and bibliography will. 

Archiving 

Backing up and Sharing References 
There are several ways to share EndNote Library references with other 
researchers. If they also use EndNote, you can give them the EndNote Library 
(.ENL file) itself, which can be imported into a library of their own, or opened to 
drag and drop individual records into a different library. 
You can save your complete library (the filename.enl file as well as its associated 
.DATA folder and all of its contents) to a single compressed file in order to easily 
back up your library or send a copy to a colleague. 

Saving to a Compressed Library File 

1. Open the library in EndNote. 
2. From the File menu, select Compressed Library.  
3. Use the file dialog to save to an EndNote Compressed Library 

(filename.enlx). 

Archival Copies: Best Practices  
 
Truism: There are two types of computer users: those who have lost data 

and those who are going to lose data. 

Keep at least two sets of backup files, each at a different location. EndNote 
recommends that you have sets for alternate days, so if you discover that 
something went wrong yesterday, you will have the day-before-yesterday’s 
version.  

Make archival sets of the files listed above whenever you finish an important 
document. An archival set should include all of the files that are needed to 
recreate a final formatted paper. Label the backup files and store them 
separately from your computer.  Burning them to CD/DVD is recommended.  
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That way, if you ever need to recreate the document, you will have all of the 
necessary files. 

FYI:  EndNote and MS Word 2007 

 
 
Microsoft Word 2007 has its own Citation and Bibliography tools found on the 
Reference ribbon.  This instrument has limited usability with EndNote.  From the 
EndNote toolbar you can convert items from Word 2007 Citation Manager to 
EndNote CWYW.  For more information about MS Words Citation tool see the 
Word2007 Help menu. 
 

 

For More Information 
Here are some additional sources of information about EndNote: 
The EndNote print user’s guide is a well-written resource that provides a great 
deal of information for both beginning and advanced users of EndNote. 
The EndNote web site, www.endnote.com, is the place to find updated versions 
of connection files, import filters, output styles, and the EndNote program itself. 
Tip sheets, a technical support database, and utility programs for repairing 
damaged EndNote Libraries and converting from other bibliography management 
tools to EndNote are also available from the Support & Services area of this site. 

Getting Additional Help 
EndNote has excellent Tutorials, Webinars and technical support: 
http://www.endnote.com/training/ 
 
Information Services provides consulting and Q&A help in a variety of ways: 
785/864-8080 
question@ku.edu 
www.ku.edu/~helpdesk  

 

http://www.endnote.com/
http://www.endnote.com/training/
mailto:question@ku.edu
http://www.ku.edu/%7Ehelpdesk
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